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1 Product description

Category Description HP
Compaq
6515b
Notebook
PC without
WWAN
capability

HP
Compaq
6515b
Notebook
PC with
WWAN
capability

Processors AMD Turion™ 64 X2 Mobile Technology processors:

● TL-64 (dual core) 2.2-GHz (1-MB L2 cache)

● MK-38 (single core) 2.2-GHz (512-KB L2 cache)

● TL-60 (dual core) 2.0-GHz (1-MB L2 cache)

● TL-56 (dual core) 1.8-GHz (1-MB L2 cache)

● TL-52 (dual core) 1.6-GHz (1-MB L2 cache)

● TL-50 (dual core) 1.6-GHz (1-MB L2 cache)

√ √

 Mobile AMD Sempron™ processors:

● 3800+ 2.2-GHz (256-KB L2 cache)

● 3600+ 2.0-GHz (256-KB L2 cache)

● 3500+ 1.8-GHz (512-KB L2 cache)

● 3400+ 1.8-GHz (256-KB L2 cache)

√ √

Chipset ● Northbridge: RS690T

● Southbridge: SB600

√ √

Graphics Unified Memory Architecture (UMA), integrated with shared video
memory

√ √

Panels ● 14.1-inch, WXGA+ with WWAN and WLAN antenna
transceivers and cables

 √

 ● 14.1-inch, WXGA+, BrightView with WLAN antenna
transceivers and cables

√  

 ● 14.1-inch, WXGA+ with WLAN antenna transceivers and
cables

√  

 ● Support privacy film √ √
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Category Description HP
Compaq
6515b
Notebook
PC without
WWAN
capability

HP
Compaq
6515b
Notebook
PC with
WWAN
capability

Memory ● Two SODIMM slots, both customer accessible/upgradable
(memory slot under the keyboard must be populated first)

● DDRII PC2-5300 (667 MHz)

● Supports dual-channel memory

√ √

 Supports the following configurations:

● 4096-MB total system memory (2048 MB × 2, dual-channel)

● 2048-MB total system memory (2048 MB × 1)

● 2048-MB total system memory (1024 MB × 2, dual-channel)

● 1024-MB total system memory (512 MB × 2, dual-channel)

● 1024-MB total system memory (1024 MB × 1)

● 512-MB total system memory (512 MB × 1)

√ √

Hard drives ● Supports all 9.5-mm, 2.5-inch hard drives

● Serial ATA

The following hard drives are available:

● 160-GB, 5400-rpm

● 120-GB, 5400-rpm

● 80-GB, 7200- and 5400-rpm

√ √

Optical drives ● 12.7-mm tray load

● Fixed, no modular requirements (1 screw removal)

Supports all common optical formats including the following:

● DVD±RW and CD-RW Super Multi Double-Layer Combo Drive
with LightScribe

● DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

● DVD/CD-RW Combo Drive

● DVD-ROM drive

√ √

Diskette drive Supports external USB drive only √ √

Audio ● Azalia

● Stereo speakers

● Integrated monoaural microphone

● Headphone and microphone jacks

√ √
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Category Description HP
Compaq
6515b
Notebook
PC without
WWAN
capability

HP
Compaq
6515b
Notebook
PC with
WWAN
capability

Modem ● 56K data/fax modem (MDC1.5)

● Modem cable included in Brazil and Latin America

√ √

Ethernet ● Integrated Broadcom 5787 10/100/1000 LAN

● S4/S5 wake on LAN (on AC power only)

● Network interface card (NIC) power down

√ √

Wireless Integrated wireless options by way of wireless module   

 Wireless local area network (WLAN) options:   

 ● Broadcom 802.11a/b/g/n √ √

 ● Broadcom 802.11a/b/g √ √

 ● Broadcom 802.11b/g √ √

 ● Option for no WLAN √  

 Wireless wide area network (WWAN) options:   

 ● Evolution-data optimized (EVDO) WWAN module  √

 ● High-speed downlink packet access (HSPDA) WWAN module  √

 ● Subscriber identity module (SIM) module  √

 Wireless personal area network (WPAN) options:

● Bluetooth® 2.0 module + Blueflame module

● Supports no WPAN option

√ √

External media card ● One Type I/II PC Card slot, 16-bit PCMCIA and 32-bit CardBus

● Media Card Reader (MS Duo Adapters, plus SD, MMC, MS,
MSPro, and xD)

√ √

Ports ● 1394a port

● Docking connector

● Headphone connector

● Microphone connector

● Primary battery connector

● RJ-11 modem port

● RJ-45 Ethernet port

● S-Video out connector

● Smart AC adaptor

● Travel battery connector

√ √
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Category Description HP
Compaq
6515b
Notebook
PC without
WWAN
capability

HP
Compaq
6515b
Notebook
PC with
WWAN
capability

● 4 USB ports

● VGA (Dsub 15-pin) supporting 1600 × 1200 external
resolution @ 75 Hz, hot plug/unplug, and auto detect

Docking Docking support √ √

Keyboard/pointing
devices

● Spill-resistant keyboard with embedded numeric keypad,
TouchPad, and fingerprint reader

● Two-way scrolling

● Windows Vista™ hardware Start button

√ √

Power requirements Primary batteries:

● 6-cell, 2.55-Ah Li-ion battery (55 Wh)

● 6-cell, 2.20-Ah Li-ion battery (47 Wh)

Travel batteries:

● 12-cell Li-ion battery

● 8-cell Li-ion battery

√ √

 90-W AC adapter with localized cable plug support (3-wire plug
with ground pin, supports multipin AC connector)

√ √

Security ● Fingerprint reader

● HP 3D DriveGuard

● Security cable slot

● Smart card reader/bezel snap in

● Trusted platform module (TPM) 1.2 on system board

√ √

Operating system Preinstalled:   

 ● Windows Vista Home Basic √ √

 ● Windows Vista Business 32/64 √ √

 ● Free DOS √ √

 ● Windows® XP Professional √ √

 Certified: SuSe Linux Enterprise Desktop (SLED) 10 √ √

 Supported: Windows Vista Enterprise √ √

Serviceability End-user replaceable parts:

● AC adapter

● Hard drive

● Memory module

√ √
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Category Description HP
Compaq
6515b
Notebook
PC without
WWAN
capability

HP
Compaq
6515b
Notebook
PC with
WWAN
capability

● Optical drive

● Primary battery

● WLAN module

● WWAN module
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2 External component identification

Top components
Buttons, switches, and fingerprint reader

Item Component Function

(1) Power button ● When the computer is off, press the button to turn on the
computer.

● When the computer is on, press the button to shut down the
computer.

● When the computer is in the Sleep state (Windows Vista) or
in Standby (Windows XP), press the button briefly to exit
Sleep or Standby.

● When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the power
button for at least 5 seconds to turn off the computer.
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Item Component Function

To learn more about power settings, follow these steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(2) Internal display switch Turns off the display if the display is closed while the power is on.

(3) Info button (select models only) Launches Info Center, which enables you to open various software
solutions.

(4) Wireless button Turns the wireless feature on or off, but does not establish a
wireless connection.

NOTE: A wireless network must be set up in order to establish
a wireless connection.

(5) Presentation button (select models only) Starts the presentation feature.

(6) Volume mute button (select models only) Mutes and restores speaker sound.

(7) Volume scroll zone (select models only) Adjusts speaker volume. Slide your finger to the left to decrease
volume and to the right to increase volume. You can also tap the
minus sign on the scroll zone to decrease volume, or tap the plus
sign on the scroll zone to increase volume.

(8) Internal microphone (select models only) Records sound.

(9) Fingerprint reader (select models only) Allows a fingerprint logon to Windows, instead of a password
logon.
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Keys

Item Component Function

(1) esc key Displays system information when pressed in combination with
the fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

Lights
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Item Component Function

(1) Power lights (2) ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power rating
should be connected.

● Off: The computer is off or in Hibernation.

(2) Wireless lights (2) ● On: An integrated wireless device, such as a wireless local
area network (WLAN) device, a wireless wide-area network
(WWAN) device, and/or a Bluetooth device is turned on.

● Off: All wireless devices are turned off.

(3) Caps lock light On: Caps lock is on.

(4) Num lock light On: Num lock is on or the embedded numeric keypad is enabled.

(5) Volume mute light (select models only) ● Off: Computer sound is turned on.

● On: Computer sound is turned off.

(6) Volume down light (select models only) Blinking: The volume scroll zone is being used to decrease speaker
volume.

(7) Volume up light (select models only) Blinking: The volume scroll zone is being used to increase speaker
volume.

(8) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(9) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.
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TouchPad

Item Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse
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Front components

Item Component Function

(1) Wireless light ● On: An integrated wireless device, such as a WLAN device,
a WWAN device, and/or a Bluetooth device, is turned on.

● Off: All wireless devices are turned off.

(2) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows Vista)
or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power rating
should be connected.

● Off: The computer is off or in Hibernation.

(3) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

(4) Drive light ● Blinking green: The hard drive or optical drive is being
accessed.

● Amber (select models only): HP 3D DriveGuard has
temporarily parked the hard drive.

(5) Display release latch Opens the computer.

(6) Speakers Produce sound.
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Left-side components

Item Component Function

(1) PC Card slot Supports optional Type I or Type II 32–bit (CardBus) or 16–bit PC
Cards.

(2) PC Card eject button Ejects a PC Card from the PC Card slot.

(3) Power connector Connects an AC adapter.

(4) Vent Enables airflow to cool internal components.

CAUTION: To prevent overheating, do not obstruct vents. Use
the computer only on a hard, flat surface. Do not allow another
hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or thick rugs or clothing, to block airflow.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) USB ports (2) Connect optional USB devices.

(6) Audio-out (headphone) jack Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

(7) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

(8) 1394 port (select models only) Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.
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Rear components

Item Component Function

(1) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.

(2) RJ-45 (network) jack Connects a network cable.

(3) External monitor port Connects an external VGA monitor or projector.

(4) S-Video-out jack Connects an optional S-Video device such as a television, VCR,
camcorder, overhead projector, or video capture card.

Right-side components

Item Component Function

(1) Media Card Reader (select models only) ● Secure Digital (SD) Memory Card

● MultiMediaCard (MMC)

● Memory Stick (MS)

● Memory Stick Pro (MSP)

● Memory Stick Duo Adapter

● xD-Picture Card (XD)

(2) USB ports (2) (select models only) Connect an optional USB device.

(3) Optical drive Reads an optical disc.

(4) RJ-11 (modem) jack Connects a modem cable.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Battery release latches Releases the battery from the battery bay.

(3) Accessory battery connector Connects an optional accessory battery.

(4) Vents (3) Enable airflow to cool internal components.

CAUTION: To prevent overheating, do not obstruct vents. Use
the computer only on a hard, flat surface. Do not allow another
hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or thick rugs or clothing, to block airflow.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5) Bluetooth module compartment (select models only) Contains a Bluetooth device.

(6) Docking connector (select models only) Connects an optional docking device.

(7) Memory/WLAN module compartment Contains the memory module slot.

(8) Hard drive bay Holds the hard drive.
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3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components
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Item Description Spare part number

(1) Display assemblies  

 14.1-inch, WXGA+ display assembly for use only with computer models with WWAN
capability

443895-001

 14.1-inch, WXGA+, BrightView display assembly for use only with computer models without
WWAN capability

443894-001

 14.1-inch, WXGA+ display assembly for use only with computer models without WWAN
capability

443893-001

 Display assembly internal components

 Display bezel 447205-001

 14.1-inch, WXGA+ display panel for use only with computer models with WWAN
capability

449823-001

 14.1-inch, WXGA+ display panel for use only with computer models without WWAN
capability

449822-001

 Display inverter (includes 2-sided tape) 446870-001

 Display left and right hinges 447204-001

 Display enclosure 450067-001

 Display Rubber Kit (includes 6 display bezel rubber screw covers in two sizes) 446881-001

 Display Screw Kit 446880-001

(2) Switch cover (includes power button board and cable and LED board and cable) 447203-001

(3) Keyboards  

 Belgium 443922-181

 Brazil 443922-201

 French Canada 443922-121

 Japan 443922-291

 Korea 443922-AD1

 Latin America 443922-161

 Taiwan 443922-AB1

 Thailand 443922-281

 The United States 443922-001

(4) Fan 443917-001

(5) WWAN modules  

 EVDO WWAN module for use in all countries and regions except Japan and Asia/Pacific 399440-001

 Vodafone HSPDA WWAN module 441772-001

 Cingular HSPDA WWAN module 441773-001

(6) Heat sink (includes thermal material) 443912-001

 Thermal Material Kit (not illustrated) 413706-001

Computer major components 17



Item Description Spare part number

(7) Memory modules, 1-DIMM  

 2048-MB, PC2-5300 417506-001

 1024-MB, PC2-5300 414046-001

 512-MB, PC2-5300 414045-001

 Cable Kit (see Cable Kit on page 23 for more Cable Kit spare part information) 443887-001

(8a) Microphone (includes receiver and cable)  

(8b) Modem module cable (includes RJ-11 connector and cable)  

(8c) Bluetooth module cable  

 Plastics Kit (see Plastics Kit on page 22 for more Plastics Kit spare part information) 443905-001

(9a) PC Card slot bezel  

(9b) Hard drive cover (includes 2 captive screws, secured by C-clips)  

(9c) Memory/WLAN module compartment cover (includes 1 captive screw, secured by a C-clip)  

(9d) Bluetooth module cover (includes 1 captive screw, secured by a C-clip)  

 Computer feet (includes 4 large rubber feet and 4 small rubber feet, not illustrated)  

(10) Processors (include thermal material)  

 Processors for use in all countries and regions except Japan and Asia/Pacific

 AMD Turion TL-64 (2.2-GHz, 1-MB L2 cache) 443913-001

 AMD Turion MK-38 (2.2-GHz, 512-KB L2 cache) 446045-001

 AMD Turion TL-60 (2.0-GHz, 1-MB L2 cache) 430876-001

 AMD Turion TL-56 (1.8-GHz, 1-MB L2 cache) 430875-001

 AMD Turion TL-52 (1.6-GHz, 1-MB L2 cache) 430874-001

 AMD Turion TL-50 (1.6-GHz, 1-MB L2 cache) 450940-001

 Mobile AMD Sempron 3800+ (2.2-GHz, 256-KB L2 cache) 450939-001

 Mobile AMD Sempron 3600+ (2.0-GHz, 256-KB L2 cache) 443916-001

 Mobile AMD Sempron 3500+ (1.8-GHz, 512-KB L2 cache) 430872-001

 Mobile AMD Sempron 3400+ (1.8-GHz, 256-KB L2 cache) 430871-001

 Processors for use only in Japan and Asia/Pacific countries and regions

 AMD Turion TL-60 (2.0-GHz, 1-MB L2 cache) 443892-001

 AMD Turion TL-56 (1.8-GHz, 1-MB L2 cache) 443891-001

 AMD Turion TL-52 (1.6-GHz, 1-MB L2 cache) 443890-001

 Mobile AMD Sempron 3500+ (1.8-GHz, 512-KB L2 cache) 443915-001

 Mobile AMD Sempron 3400+ (1.8-GHz, 256-KB L2 cache) 443914-001

(11) Top cover (includes TouchPad, TouchPad cable, and fingerprint reader) 443921-001

(12) PC Card/audio board assembly 443889-001
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Item Description Spare part number

(13) RTC battery 449137-001

(14) System boards  

 For use only with computer models with WWAN capability (includes WWAN module socket) 443896-001

 For use only with computer models without WWAN capability (does not include WWAN
module socket)

443898-001

(15) SIM module slot board (for use only with computer models with WWAN capability) 443907-001

(16) Speaker 443909-001

(17) Modem module (includes modem module cable) 443899-001

(18) Media Card Reader/USB connector boards  

 For use only with computer models with WWAN capability 448052-001

 For use only with computer models without WWAN capability 443883-001

(19) Base enclosure (includes 8 rubber feet, not illustrated) 443886-001

(20) Batteries  

 6-cell, 2.55-Ah, 55-Wh, Li ion battery 443885-001

 6-cell, 2.20-Ah, 47-Wh, Li ion battery 443884-001

(21) Hard drives (include hard drive bracket and connector)  

 160-GB, 5400-rpm 443920-001

 120-GB, 5400-rpm 443919-001

 80-GB, 7200-rpm 445939-001

 80-GB, 5400-rpm 443918-001

(22) WLAN modules  

 802.11a/b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the United States, and the Virgin Islands

441530-001

 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua & Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bhutan,
Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic of
Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St.
Lucia, St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,

441530-002
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Item Description Spare part number

the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

 802.11a/b/g/n WLAN module for use in Israel and Japan 441530-291

 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico,
the United States, and the Virgin Islands

441075-001

 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua & Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the
Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-002

 802.11a/b/g WLAN module for use in Japan 441075-291

 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the
United States, and the U.S. Virgin Islands

441060-001

 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua & Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador,
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo,
Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441060-002

20 Chapter 3   Illustrated parts catalog



Item Description Spare part number

 802.11a/b/g WLAN module for use in Japan 441060-291

(23) Bluetooth modules (include Bluetooth module cable)  

 For use only with computer models in all countries or regions except for Japan and Asia Pacific 398393-002

 For use only with computer models in Japan and Asia Pacific countries or regions 450066-001

(24) Optical drives (include bezel and optical drive bracket)  

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

 DVD/CD-RW Combo Drive 443901-001

 DVD-ROM drive 443902-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit 441630-001

(1) PC Card slot bezel  

(2) Hard drive cover (includes 2 captive screws, secured by C-clips)  

(3) Memory/WLAN module compartment cover (includes 1 captive screw, secured by a C-clip)  

(4) Bluetooth module cover (includes 1 captive screw, secured by a C-clip)  

(5) Computer feet (4 large, 4 small)  
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Cable Kit

Item Description Spare part number

 Cable Kit 443887-001

(1) modem module cable (includes RJ-11 connector and cable)  

(2) Microphone (includes receiver and cable)  

(3) Bluetooth module cable  
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Mass storage devices

Item Description Spare part number

(1) Hard drives (include frame and connector)  

 160-GB, 5400-rpm 443920-001

 120-GB, 5400-rpm 443919-001

 80-GB, 7200-rpm 445939-001

 80-GB, 5400-rpm 443918-001

(2) Optical drives (include bezel and optical drive bracket)  

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

 DVD/CD-RW Combo Drive 443901-001

 DVD-ROM drive 443902-001
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Miscellaneous parts
Description Spare part number

AC adapters  

90-watt PFC AC adapter for use only with computer models in Africa, Europe, and the Middle East 416421-021

90-watt PFC AC adapter for use only with computer models in North America 391173-001

Power cords:  

Australia 246959-011

Brazil 246959-201

Denmark 246959-081

Europe, the Middle East, and Africa 246959-021

Israel 246959-BB1

Italy 246959-061

Japan 246959-291

Korea 246959-AD1

Switzerland 246959-AG1

The United Kingdom 246959-031

The United States 246959-001

Screw Kit

Hex HM5.0×9.0 screw lock

Phillips PM3.0×3.0 screw

Phillips PM2.5×13.0 captive screw

Black Phillips PM2.5×8.0 captive screw

Silver Phillips PM2.5×8.0 captive screw

Phillips PM2.5×8.0 screw

Phillips PM2.5×5.0 screw

Phillips PM2.5×3.0 screw

Phillips PM2.0×6.0 screw

Phillips PM2.0×5.0 captive screw

Phillips PM2.0×3.0 screw

Torx8 T8M2.5×17.0 screw

Torx8 T8M2.5×9.0 screw

Torx8 T8M2.5×7.0 screw

Torx8 T8M2.5×6.0 screw

443906-001

Smart card reader module 443908-001
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Sequential part number listing
Spare part
number

Description

246959-001 Power cord for use in the United States

246959-011 Power cord for use in Australia

246959-021 Power cord for use in Europe, the Middle East, and Africa

246959-031 Power cord for use in the United Kingdom

246959-061 Power cord for use in Italy

246959-081 Power cord for use in Denmark

246959-201 Power cord for use in Brazil

246959-291 Power cord for use in Japan

246959-AD1 Power cord for use in Korea

246959-AG1 Power cord for use in Switzerland

246959-BB1 Power cord for use in Israel

391173-001 90-watt PFC AC adapter

398393-002 Bluetooth module for use only with computer models in all countries or regions except Japan and Asia Pacific
(includes Bluetooth module cable)

399440-001 EVDO WWAN module

413706-001 Thermal Material Kit

414045-001 512-MB, PC-5300, 1-DIMM memory module

414046-001 1024-MB, PC-5300, 1-DIMM memory module

416421-021 90-watt AC adapter

417506-001 2048-MB, PC-5300, 1-DIMM memory module

430871-001 Mobile AMD Sempron 3400+ 1.8-GHz processor for use in all countries and regions except Japan and Asia/
Pacific (256-KB L2 cache)

430872-001 Mobile AMD Sempron 3500+ 1.8-GHz processor for use in all countries and regions except Japan and Asia/
Pacific (256-KB L2 cache)

430874-001 AMD Turion TL-52 1.6-GHz processor for use in all countries and regions except Japan and Asia/Pacific (1-MB
L2 cache)

430875-001 AMD Turion TL-56 1.8-GHz processor for use in all countries and regions except Japan and Asia/Pacific (1-MB
L2 cache)

430876-001 AMD Turion TL-60 2.0-GHz processor for use in all countries and regions except Japan and Asia/Pacific (1-MB
L2 cache)

441060-001 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and
the Virgin Islands

441060-002 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
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Spare part
number

Description

Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441060-291 802.11b/g WLAN module for use in Japan

441075-001 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States,
and the Virgin Islands

441075-002 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal,
Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-291 802.11a/b/g WLAN module for use in Japan

441530-001 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United States, and
the U.S. Virgin Islands

441530-002 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial
Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
& Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia,
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Spare part
number

Description

St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo,
Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441530-291 802.11b/g WLAN module for use in Japan

441772-001 Vodafone HSPDA WWAN module

441773-001 Cingular HSPDA WWAN module

443883-001 Media Card Reader/USB connector board for use only with computer models without WWAN capability

443884-001 6-cell, 2.20-Ah, 47-Wh battery

443885-001 6-cell, 2.55-Ah, 55-Wh battery

443886-001 Base enclosure (includes 6 rubber feet)

443887-001 Cable Kit

443889-001 PC Card/audio board assembly

443890-001 AMD Turion TL-52 1.6-GHz processor for use only in Japan and Asia/Pacific countries and regions (1-MB L2
cache)

443891-001 AMD Turion TL-56 1.8-GHz processor for use only in Japan and Asia/Pacific countries and regions (1-MB L2
cache)

443892-001 AMD Turion TL-64 (2.0-GHz, 1-MB L2 cache) processor

443893-001 14.1-inch WXGA+ display assembly for use only with computer models without WWAN capability

443894-001 14.1-inch WXGA+, BrightView display assembly for use only with computer models without WWAN capability

443895-001 14.1-inch WXGA+ display assembly for use only with computer models with WWAN capability

443896-001 System board for use only with computer models with WWAN capability (includes WWAN module socket)

443898-001 System board for use only with computer models without WWAN capability (does not include WWAN module
socket)

443899-001 Modem module (includes modem module cable)

443901-001 DVD/CD-RW Combo Drive

443902-001 DVD-ROM drive

443903-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe

443904-001 DVD±RW and CD-RW Super Multi Double-Layer Combo Drive

443905-001 Plastics Kit

443906-001 Screw Kit

443907-001 SIM module slot board (for use only with computer models with WWAN capability)

443908-001 Smart card reader module

443909-001 Speaker

443912-001 Heat sink (includes thermal material)

443913-001 AMD Turion TL-64 2.2-GHz processor for use in all countries and regions except Japan and Asia/Pacific (1-MB
L2 cache)
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Spare part
number

Description

443914-001 Mobile AMD Sempron 3400+ 1.8-GHz processor for use only in Japan and Asia/Pacific countries and regions
(256-KB L2 cache)

443915-001 Mobile AMD Sempron 3500+ 1.8-GHz processor for use only in Japan and Asia/Pacific countries and regions
(512-KB L2 cache)

443916-001 Mobile AMD Sempron 3600+ 2.0-GHz processor not for use in Japan and Asia/Pacific countries and regions
(256-KB L2 cache)

443917-001 Fan

443918-001 80-GB, 5400-rpm hard drive

443919-001 120-GB, 5400-rpm hard drive

443920-001 160-GB, 5400-rpm hard drive

443921-001 Top cover (includes TouchPad, TouchPad cable, and fingerprint reader)

443922-001 Keyboard for use in the United States

443922-121 Keyboard for use in French Canada

443922-161 Keyboard for use in Latin America

443922-181 Keyboard for use in Belgium

443922-201 Keyboard for use in Brazil

443922-281 Keyboard for use in Thailand

443922-291 Keyboard for use in Japan

443922-AB1 Keyboard for use in Taiwan

443922-AD1 Keyboard for use in Korea

445853-001 Thermal Material Kit for use only in Japan and Asia/Pacific countries and regions

445939-001 80-GB, 7200-rpm hard drive

446045-001 AMD Turion MK-38 2.2-GHz processor for use in all countries and regions except Japan and Asia/Pacific (512-
KB L2 cache)

446870-001 Display inverter (includes 2-sided tape)

446880-001 Display Screw Kit

446881-001 Display Rubber Kit (includes 6 display bezel rubber screw covers)

446882-001 Display left and right hinges

447203-001 Switch cover (includes power button board and cable and LED board and cable)

447204-001 Display left and right hinges

447205-001 Display bezel

448052-001 Media Card Reader/USB connector board for use only with computer models with WWAN capability

449137-001 RTC battery

449822-001 14.1-inch, WXGA+ display panel for use only with computer models without WWAN capability

449823-001 14.1-inch, WXGA+ display panel for use only with computer models with WWAN capability
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Spare part
number

Description

450066-001 Bluetooth module for use only with computer models in Japan and Asia Pacific countries or regions (includes
Bluetooth module cable)

450067-001 Display enclosure

450939-001 Mobile AMD Sempron 3800+ 2.2-GHz processor for use in all countries and regions except Japan and Asia/
Pacific (256-KB L2 cache)

450940-001 AMD Turion TL-50 1.6-GHz processor for use in all countries and regions except Japan and Asia/Pacific (1-MB
L2 cache)
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4 Removal and replacement
procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Hex 5.0-mm nutdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you should keep in mind during disassembly
and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer
is off or in Hibernation, turn the computer on, and then shut it down through the operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be
sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described in
this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
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CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 v 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized
equipment used for moving materials is wired to ground and that proper materials are selected to
avoid static charging. When grounding is not possible, use an ionizer to dissipate electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these
items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can
be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one megohm
resistance between the operator and ground. To be effective, the conductive strips must be worn in
contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 56).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 78 screws and screw locks, in 17 different sizes, that must be removed, replaced,
or loosened when servicing the computer. Make special note of each screw and screw lock size and
location during removal and replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The serial
number is located on the bottom of the computer.
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Battery

Description Spare part number

6-cell, 2.55-Ah, 55-Wh, Li ion battery 443885-001

6-cell, 2.20-Ah, 47-Wh, Li ion battery 443884-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the right-hand battery release latch (1) to the right, and then release the latch.

3. Slide and hold the left-hand battery release latch (2) to the right.

4. Remove the battery (3) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM module
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM module inserted in the SIM module slot, it should be removed before
disassembling the computer. Be sure the SIM module is reinserted in the SIM module slot after reassembling
the computer.

Before removing the SIM module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

Remove the SIM module:

1. Press in on the SIM module (1). (The module is partially ejected from the SIM module slot.)

2. Remove the SIM module (2) from the SIM module slot.

Reverse this procedure to install the SIM module.
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Display inverter
NOTE: If it has been determined that the display inverter is the component that must be replaced to
complete the computer repair, the display assembly does not have to be removed. Follow the procedures
in this section to replace the display inverter. For information on replacing the display assembly and
display hinges, see Display assembly on page 64.

Description Spare part number

Display inverter (includes 2-sided tape) 446870-001

Before removing the display inverter, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

Remove the display inverter:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as it will open.

3. Remove the two rubber screw covers (1) on the bottom edge of the display bezel.

4. Remove the two Torx8 T8M2.5×7.0 screws (2) that secure the bottom edge of the display bezel to
the display enclosure.

NOTE: The display bezel rubber screw covers are included in the Display Rubber Kit, spare part
number 446881-001. The display bezel screws are included in the Display Screw Kit, spare part
number 446880-001.

5. Flex the inside edges of the left and right sides (1) and the bottom edge (2) of the display bezel until
the bezel disengages from the display enclosure.
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6. Release the bottom edge of the display bezel (3) from the display assembly.

7. Release the inverter (1) from the display enclosure as far as the cables attached to it allow.

8. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

9. Remove the display inverter.

Reverse this procedure to install the display inverter.
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Hard drive

Description Spare part number

160-GB, 5400-rpm hard drive 443920-001

120-GB, 5400-rpm hard drive 443919-001

80-GB, 7200-rpm hard drive 445939-001

80-GB, 5400-rpm hard drive 443918-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×5.0 screws (1) that secure the hard drive cover to the computer.

3. Lift the left side of the hard drive cover (2), swing it to right, and remove the cover.

NOTE: The hard drive cover is included in the Plastics Kit, spare part number 443905-001.

4. Loosen the Phillips PM2.5×13.0 hard drive retention screw (1) that secures the hard drive to the
computer.

5. Grasp the Mylar tab (2) on the hard drive and pull the hard drive (3) to the right to disconnect it
from the system board.
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6. Remove the hard drive (4) from the hard drive bay.

7. If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×3.0 hard drive
bracket screws (1) from each side of the hard drive.

8. Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Plastics Kit, spare part
number 443905-001. There are 8 feet in 2 different sizes. The feet attach to the base enclosure in the
locations illustrated below.

Bluetooth module

Description Spare part number

For use only with computer models in all countries or regions except for Japan and Asia Pacific
(includes Bluetooth module cable)

398393-002

For use only with computer models in Japan and Asia Pacific countries or regions (includes Bluetooth
module cable)

450066-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

Remove the Bluetooth® module:

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×5.0 screw (1) that secures the Bluetooth module cover to the computer.
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3. Lift the rear edge of the cover (2), swing it forward, and remove the cover.

NOTE: The Bluetooth module cover is included in the Plastics Kit, spare part number 443905-001.

4. Remove the Bluetooth module (1) from the computer.

5. Disconnect the Bluetooth module cable (2) from the module.

6. Remove the Bluetooth module.

Reverse this procedure to reassemble and install the Bluetooth module.
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Expansion memory module

Description Spare part number

2048-MB, PC2-5300, 1-DIMM memory module 417506-001

1024-MB, PC2-5300, 1-DIMM memory module 414046-001

512-MB, PC2-5300, 1-DIMM memory module 414045-001

Before removing the expansion memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

Remove the expansion memory module:

1. Loosen the Phillips PM2.0×5.0 screw (1) that secures the memory/WLAN module compartment
cover to the computer.

2. Lift the rear edge of the cover (2), swing it forward, and remove the cover.

NOTE: The memory/WLAN module compartment cover is included in the Plastics Kit, spare part
number 443905-001.

3. Spread the retaining tabs (1) on each side of the memory module socket to release the memory
module. (The edge of the module opposite the socket rises away from the computer.)
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4. Remove the memory module (2) by pulling the module away from the socket at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module socket.

Reverse this procedure to install the expansion memory module.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

802.11a/b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the
United States, and the Virgin Islands

441530-001

802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
& Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros, Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary,
Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka,
St. Kitts & Nevis, St. Lucia, St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441530-002

802.11a/b/g/n WLAN module for use in Israel and Japan 441530-291

802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United
States, and the Virgin Islands

441075-001

802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia &
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, China, Colombia, Comoros,
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Gren,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad &
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and
Zimbabwe

441075-002

802.11a/b/g WLAN module for use in Japan 441074-291

802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the United
States, and the U.S. Virgin Islands

441060-001
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Description Spare part number

802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia &
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, China, Colombia,
Comoros, Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia,
Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, Qatar, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis,
St. Lucia, St. Vincent & Gren, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441060-002

802.11b/g WLAN module for use in Japan 441060-291

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable (2) is
connected to the middle terminal on the WLAN module.

2. Remove the two Phillips PM2.5×3.0 screws (3) that secure the WLAN module to the computer. (The
edge of the module opposite the socket rises away from the computer.)
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3. Remove the WLAN module (4) by pulling the module away from the socket at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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Optical drive
NOTE: All optical drive spare part kits include an optical drive bezel and optical drive bracket.

Description Spare part number

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive with LightScribe 443903-001

DVD±RW and CD-RW Super Multi Double-Layer Combo Drive 443904-001

DVD/CD-RW Combo Drive 443901-001

DVD-ROM drive 443902-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

Remove the optical drive:

1. Position the computer with left side toward you.

2. Remove the Torx T8M2.5×9.0 screw (1) that secures the optical drive to the computer.

3. Use a flat-bladed tool to push the metal tab (2) toward the left side of the computer. (The optical
drive is partially ejected from the optical drive bay.)

4. Remove the optical drive (3) from the computer.
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5. If it is necessary to replace the optical drive bracket, remove the two Phillips PM2.0×3.0 screws
(1) that secure the bracket to the optical drive.

6. Remove the optical drive bracket (2).

Reverse this procedure to reassemble and install the optical drive.
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Keyboard

Country or region Spare part number Country or region Spare part number

Belgium

Brazil

French Canada

Japan

Korea

443922-181

443922-201

443922-121

443922-291

443922-AD1

Latin America

Taiwan

Thailand

The United States

443922-161

443922-AB1

443922-281

443922-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

Remove the keyboard:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.5×8.0 screws that secure the keyboard to the computer.

3. Turn the computer display-side up, with the front toward you.

4. Open the computer as far as possible.

5. Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the f4 and f5 keys, between the f8 and f9 keys, and between the f12 and scroll
keys.
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6. Lift the rear edge of the keyboard (2) and swing it toward you until it rests on the palm rest.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Internal memory module

Description Spare part number

2048-MB, PC-5300, 1-DIMM memory module 417506-001

1024-MB, PC-5300, 1-DIMM memory module 414046-001

512-MB, PC-5300, 1-DIMM memory module 414045-001

Before removing the internal memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

6. Release the keyboard (see Keyboard on page 53).

Remove the internal memory module:

1. Spread the retaining tabs (1) on each side of the memory module socket to release the memory
module. (The edge of the module opposite the socket rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the socket at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module socket.

Reverse this procedure to install the internal memory module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords
and CMOS settings to be cleared.

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

6. Release the keyboard (see Keyboard on page 53).

Remove the RTC battery:

� Use a non-conductive, flat-bladed tool to pry the RTC battery out of the socket.

Reverse this procedure to install the RTC battery. Be sure the RTC battery is installed with the “+” sign
facing up.
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WWAN module
CAUTION: The WWAN module and WLAN module are not interchangeable.

Description Spare part number

EVDO WWAN module for use in all countries and regions except Japan and Asia/Pacific 399440-001

Vodafone HSPDA WWAN module 441772-001

Cingular HSPDA WWAN module 441773-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

6. Release the keyboard (see Keyboard on page 53).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the socket rises away from the computer.)
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3. Remove the WWAN module (3) by pulling the module away from the socket at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect installation.

Reverse this procedure to install the WWAN module.

Switch cover

Description Spare part number

Switch cover (includes power button board and cable and LED board and cable) 447203-001

Before removing the switch cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the keyboard (see Keyboard on page 53).

Remove the switch cover:

1. Release the ZIF connector (1) to which the LED board cable is attached and disconnect the LED board
cable (2) from the system board.
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2. Insert a flat-bladed tool into one of the four slots (3) in the switch cover and lift the switch cover
(4) until it disengages from the computer.

3. Remove the switch cover.

Reverse this procedure to install the switch cover.

Fan

Description Spare part number

Fan 443917-001

Before removing the fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the keyboard (see Keyboard on page 53).

6. Remove the switch cover (see Switch cover on page 58).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Loosen the Phillips PM2.5×8.0 captive screw (2) that secures the fan to the computer.

3. Remove the Phillips PM2.5×8.0 screw (3) that secures the fan to the computer.
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4. Remove the fan (4).

Reverse this procedure to install the fan.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left and
right sides of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software applications. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.

Heat sink

Description Spare part number

Heat sink (includes thermal material) 443912-001

Thermal Material Kit for use in all countries and regions except Japan and Asia/Pacific 413706-001

Thermal Material Kit for use only in Japan and Asia Pacific countries and regions 445853-001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the keyboard (see Keyboard on page 53).
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6. Remove the switch cover (see Switch cover on page 58).

7. Remove the fan (see Fan on page 59).

Remove the heat sink:

1. Remove the four Phillips PM2.0×6.0 screws (1) that secure the heat sink to the system board.

2. Release the heat sink (2) by lifting the right side until it disengages from the processor.

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
processor, it may be necessary to move the heat sink from side to side to detach the heat sink from
the processor.

3. Remove the heat sink (3) by swinging it counterclockwise until the left side of the heat sink clears the
top cover.

NOTE: The thermal material should be thoroughly cleaned from the surfaces of the heat sink (1)
and the processor and system board components (2) each time the heat sink is removed. Thermal
material is included with all heat sink and processor spare part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include thermal material.

Description Spare part number

Processors for use in all countries and regions except Japan and Asia/Pacific:

AMD Turion TL-64, 2.2-GHz processor (1-MB L2 cache) 443913-001

AMD Turion MK-38, 2.2-GHz processor (512-KB L2 cache) 446045-001

AMD Turion TL-60, 2.0-GHz processor (1-MB L2 cache) 430876-001

AMD Turion TL-56, 1.8-GHz processor (1-MB L2 cache) 430875-001

AMD Turion TL-52, 1.6-GHz processor (1-MB L2 cache) 430874-001

AMD Turion TL-50, 1.6-GHz processor (1-MB L2 cache) 450940-001

Mobile AMD Sempron 3800+ 2.2-GHz processor (256-KB L2 cache) 450939-001

Mobile AMD Sempron 3600+ 2.0-GHz processor (256-KB L2 cache) 443916-001

Mobile AMD Sempron 3500+ 1.8-GHz processor (512-KB L2 cache) 430872-001

Mobile AMD Sempron 3400+ 1.8-GHz processor (256-KB L2 cache) 430871-001

Processors for use only in Japan and Asia/Pacific countries and regions:

AMD Turion TL-60, 2.0-GHz processor (1-MB L2 cache) 443892-001

AMD Turion TL-56, 1.8-GHz processor (1-MB L2 cache) 443891-001

AMD Turion TL-52, 1.6-GHz processor (1-MB L2 cache) 443890-001

Mobile AMD Sempron 3500+ 1.8-GHz processor (512-KB L2 cache) 443915-001

Mobile AMD Sempron 3400+ 1.8-GHz processor (256-KB L2 cache) 443914-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Release the keyboard (see Keyboard on page 53).

6. Remove the switch cover (see Switch cover on page 58).

7. Remove the fan (see Fan on page 59).

8. Remove the heat sink (see Heat sink on page 60).
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Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

2. Lift the processor (2) straight up and remove it.

NOTE: The gold triangle (3) on the processor should be aligned with the triangle (4) embossed
on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Display assembly

Description Spare part number

14.1-inch, WXGA+ display assembly for use only with computer models with WWAN capability 443895-001

14.1-inch, WXGA+, BrightView display assembly for use only with computer models without WWAN
capability

443894-001

14.1-inch, WXGA+ display assembly for use only with computer models without WWAN capability 443893-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the memory/WLAN module compartment cover (see Expansion memory module
on page 46).

6. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 48).

7. Remove the following components:

a. Keyboard (see Keyboard on page 53)

b. Switch cover (see Switch cover on page 58)

Remove the display assembly:

1. Disconnect the display panel cable (1) from the system board.

2. Remove the wireless antenna cables (2) from the routing channels and clips built into the top cover.
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3. Remove the Torx T8M2.5×17.0 screw (1) and the Torx T8M2.5×7.0 screw (2) that secure the
display assembly to the computer.

4. Position the computer with the rear panel toward you.

5. Remove the four Torx T8M2.5×9.0 screws (1) that secure the display assembly to the computer.
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6. Lift the display assembly straight up and remove it (2).

CAUTION: When installing the display assembly, be sure that the wireless antenna cables routed
out of the display assembly right hinge are routed and arranged properly. Each antenna cable has
an exposed section of cable (1) and a metallic grounding sleeve (2). The grounding sleeve must
completely cover the exposed section of cable. Each cable must be secured inside a space in the
copper grounding clip (3). Left to right, the cables should be installed in a red, blue, white, black,
sequence.

Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
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7. If it is necessary to replace the display hinges, remove the following:

(1) Four rubber screw covers from the display bezel top edge

(2) Four Torx8 T8M2.5×6.0 screws from the display bezel top edge

(3) Two rubber screw covers from the display bezel bottom edge

(4) Two Torx8 T8M2.5×7.0 screws from the display bezel top edge

NOTE: The display bezel rubber screw covers are included in the Display Rubber Kit, spare part
number 446881-001. The display bezel screws are included in the Display Screw Kit, spare part
number 446880-001.

8. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.

9. Remove the display bezel (3).

NOTE: The display bezel is available using spare part number 447205-001.
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10. Remove the six Torx8 T8M2.5×6.0 screws (1) that secure the display panel to the display
enclosure.

11. Remove the display panel (2).

12. Remove the four Phillips PM2.0×3.0 screws (1) that secure each display hinge to the display panel.

13. Remove the display hinges (2).

NOTE: The left and right display hinges are available using spare part number 446882-001.

Reverse this procedure to install the display assembly.
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Top cover

Description Spare part number

Top cover (includes TouchPad, TouchPad cable, and fingerprint reader) 443921-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)

f. Display assembly (see Display assembly on page 64)

Remove the top cover:

1. Turn the computer upside down, with the rear panel toward you.

2. Remove the two rubber screw covers (1) on the front edge of the computer.

3. Remove the eleven Torx T8M2.5×9.0 screws (2) that secure the top cover to the computer.
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4. Remove the two HM5.0×9.0 screw locks (3) that secure the top cover to the computer.

5. Turn the computer right-side up, with the front toward you.

6. Disconnect the TouchPad cable (1) and the fingerprint reader board cable (2) from the system board.

7. Remove the microphone (3) from the clip built into the top cover and remove the microphone cable
from the clips built into the top cover.
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8. Remove the two Torx T8M2.5×9.0 screws that secure the top cover to the computer.

9. Lift the rear edge of the top cover (1) until it disengages from the base enclosure.

10. Swing the rear edge of the top cover (2) toward you until it rests at an angle.

11. Remove the top cover (3) by lifting it straight up.

12. If it is necessary to replace the microphone and cable, disconnect the microphone cable (1) from
the PC Card/audio board and remove it.

NOTE: The microphone is available in the Cable Kit, spare part number 443887-001.
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13. If it is necessary to replace the Bluetooth module cable, disconnect the cable (2) from the system
board and remove the cable from the opening (3) in the base enclosure.

NOTE: The Bluetooth module cable is included with the Bluetooth module, spare part numbers
398393-002 (for use only with computer models in all countries or regions except for Japan and
Asia Pacific) and 450066-001 (for use only with computer models in Japan and Asia Pacific
countries or regions), and is also available in the Cable Kit, spare part number 443887-001.

14. If it is necessary to replace the modem module cable, disconnect the cable (1) from the modem
module and the system board (2), and remove the modem connector (3) from the clip built into the
base enclosure.

NOTE: The modem module cable is available in the Cable Kit, spare part number 443887-001.

Reverse this procedure to install the top cover, microphone, Bluetooth module cable, and modem module
cable.
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Speaker

Description Spare part number

Speaker 443909-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)

f. Display assembly (see Display assembly on page 64)

g. Top cover (see Top cover on page 69)

Remove the speaker:

1. Disconnect the speaker cable (1) from the PC Card/audio board assembly.

2. Remove the two Phillips PM2.5×5.0 screws (2) and the Phillips PM2.0×3.0 screw (3) that secure
the speaker to the base enclosure.
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3. Remove the speaker (4).

Reverse this procedure to install the speaker.

Media Card Reader/USB connector board
NOTE: All Media Card Reader/USB connector board spare part kits include a Media Card Reader/
USB connector board cable.

Description Spare part number

For use only with computer models with WWAN capability 448052-001

For use only with computer models without WWAN capability 443883-001

Before removing the Media Card Reader/USB connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)
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f. Display assembly (see Display assembly on page 64)

g. Top cover (see Top cover on page 69)

Remove the Media Card Reader/USB connector board:

1. Disconnect the Media Card Reader/USB connector board cable (1) from the system board.

2. Remove the two Phillips PM2.5×5.0 screws (2) that secure the Media Card Reader/USB connector
board to the computer.

3. Lift the Media Card Reader/USB connector board (3) straight up and remove it.

Reverse this procedure to install the Media Card Reader/USB connector board.

Component replacement procedures 75



System board

Description Spare part number

For use only with computer models with WWAN capability (includes WWAN module socket) 443896-001

For use only with computer models without WWAN capability (does not include WWAN module
socket)

443898-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)

f. Fan (see Fan on page 59)

g. Heat sink (see Heat sink on page 60)

h. Display assembly (see Display assembly on page 64)

i. Top cover (see Top cover on page 69)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● SIM module (see SIM module on page 39)

● Memory modules (see Expansion memory module on page 46) and Internal memory module
on page 55)

● WLAN module (see WLAN module on page 48)

● RTC battery (see RTC battery on page 56)

● WWAN module (see WWAN module on page 57)

● Processor (see Processor on page 62)
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Remove the system board:

1. Press the PC Card eject button (1) twice. The first press releases the PC Card eject button from the
PC Card slot. The second press releases the PC Card slot bezel from the PC Card slot. (The PC Card
slot bezel is partially ejected from the PC Card slot.)

2. Remove the PC Card slot bezel (2) from the PC Card slot.

NOTE: The PC Card slot bezel is included in the Plastics Kit, spare part number 443905-001.

3. Disconnect the Media Card Reader/USB connector board cable (3) from the system board.

4. Remove the three Phillips PM2.5×5.0 screws (1) that secure the system board to the top cover.

NOTE: If the computer is equipped with a WWAN module, an additional Phillips PM2.5×5.0
screw (2) must be removed.

5. Use the optical drive connector (1) to lift the right side of the system board (2) until the rear left
corner of the system board (3) clears the base enclosure.
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6. Remove the system board (4) by pulling it away from the top cover at an angle until it clears the top
cover

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● PC Card/audio board assembly (see PC Card/audio board assembly on page 79)

● Modem module (see Modem module on page 80)

● SIM module slot board (see SIM module slot board on page 82)

Reverse the preceding procedure to install the system board.
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PC Card/audio board assembly

Description Spare part number

PC Card/audio board assembly 443889-001

Before removing the PC Card/audio board assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)

f. Fan (see Fan on page 59)

g. Heat sink (see Heat sink on page 60)

h. Display assembly (see Display assembly on page 64)

i. Top cover (see Top cover on page 69)

j. System board (see System board on page 76)

Remove the PC Card/audio board assembly:

1. Remove the Phillips PM2.5×5.0 screw (1) that secures the PC Card/audio board assembly to the
system board.

2. Lift the left side of the PC Card/audio board assembly (2) until it disengages from the system board.
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3. Remove the PC Card/audio board assembly (3) by pulling it away from the system board at an
angle.

Reverse this procedure to install the PC Card/audio board assembly.

Modem module

Description Spare part number

Modem module (includes modem module cable) 443899-001

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)

f. Fan (see Fan on page 59)

g. Heat sink (see Heat sink on page 60)
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h. Display assembly (see Display assembly on page 64)

i. Top cover (see Top cover on page 69)

j. System board (see System board on page 76)

k. PC Card/audio board assembly (see PC Card/audio board assembly on page 79)

Remove the modem module:

1. Turn the PC Card/audio board assembly upside down.

2. Remove the two Phillips PM2.5×3.0 screws (1) that secure the modem module to the PC Card/audio
board assembly.

3. Lift the modem module (2) straight up and remove it.

Reverse this procedure to install the modem module.
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SIM module slot board
NOTE: This section applies only to computer models with WWAN capability.

Description Spare part number

SIM module slot board 443907-001

Before removing the SIM module slot board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 38).

5. Remove the following components:

a. Hard drive (see Hard drive on page 42)

b. Memory/WLAN module compartment cover (see Expansion memory module on page 46)

c. Optical drive (see Optical drive on page 51)

d. Keyboard (see Keyboard on page 53)

e. Switch cover (see Switch cover on page 58)

f. Fan (see Fan on page 59)

g. Heat sink (see Heat sink on page 60)

h. Display assembly (see Display assembly on page 64)

i. Top cover (see Top cover on page 69)

j. System board (see System board on page 76)

Remove the SIM module slot board:

1. Turn the system board right-side up, with the front toward you.
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2. Lift the SIM module slot board (1) straight up and remove it, making note of the location of the
pins (2) on the SIM module slot board and their alignment with the system board.

Reverse this procedure to install the SIM module slot board.
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5 Computer Setup

WARNING! Only authorized technicians trained by HP should repair this equipment. All
troubleshooting and repair procedures are detailed to allow repair at only the subassembly or module
level. Because of the complexity of the individual boards and subassemblies, do not attempt to make
repairs at the component level or modifications to any printed wiring board. Improper repairs can create
a safety hazard. Any indication of component replacement or printed wiring board modification may void
any warranty or exchange allowances.

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is
not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup:

1. Turn on or restart the computer.

2. Before Windows® opens and while the “Press <F10> to enter setup” message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and
selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you restore
the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

Password options Enter, change, or delete a power-on password.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup by
turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions available
in Embedded Security for ProtectTools. For more information, refer to the
ProtectTools software Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase cycles
from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.
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Diagnostics menu

Select To do this

Hard Disk Self-Test options Run a comprehensive self-test on any hard drive in the system or on any optional
MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.

System Configuration menu

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette drive,
or optical drive connected by a USB port to the computer or to an optional
docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code execution,
which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

88 Chapter 5   Computer Setup



Select To do this

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.
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6 Specifications

Computer specifications
 Metric U.S.

Dimensions   

Height (front to back) 3.39 to 3.95 cm 1.32 to 1.56 in

Width 33.1 cm 13.03 in

Depth 24.3 cm 9.57 in

Weight (with optical drive, hard drive, and battery) 2.44 kg 5.38 lbs

Input power  

Operating voltage 19.0 V dc @ 4.74 A – 90 W

Operating current 4.74 A

Temperature  

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity  

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)   

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock  

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min
sweep rate
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 Metric U.S.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min
sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

14.1-inch, WXGA+ display specifications
 Metric U.S.

Dimensions   

Height 21.3 cm 8.40 in

Width 28.5 cm 11.20 in

Diagonal 35.8 cm 14.10 in

Number of colors Up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 180 nits (typical)

Pixel resolution  

Pitch 0.259 × 0.259 mm

Format 1440 × 900

Configuration RGB vertical stripe

Backlight CCFT

Character display 80 × 25

Total power consumption 6.5.0 W

Viewing angle +/-45° horizontal, +15/-35° vertical (typical)
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Hard drive specifications
 160-GB* 120-GB* 80-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 312,560,640 234,420,480 156,280,320

Disc rotational speed 5400 rpm 5400 rpm 7200 and 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive specifications
may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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Primary 6-cell, Li-ion battery specifications
 Metric U.S.

Dimensions

Height 2.0 cm 0.79 in

Width 20.3 cm 7.99 in

Depth 5.3 cm 2.09 in

Weight 0.34 kg 0.75 lb

Energy

Voltage 14.4 V

Amp-hour capacity 2.2 Ah and 2.55 Ah

Watt-hour capacity 47 Wh and 55Wh

Temperature

Operating 5°C to 45°C 41°F to 113°F

Nonoperating 0°C to 60°C 32°F to 140°F
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DVD±RW and CD-RW Super Multi Double-Layer
Combo Drive specifications

 Read: Write:

Applicable disc CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD
+R, DVD+RW, DVD-RAM

CD-R and CD-RW

DVD+R, DVD+RW, DVD-R, DVD-RW,
DVD-RAM

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 175 ms < 230 ms

Full stroke < 285 ms < 335 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD-ROM 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8X DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA Mode

Startup time < 15 seconds

Stop time < 6 seconds
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DVD/CD-RW Combo Drive specifications
 Read: Write:

Applicable disc CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video
CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R,
CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD
+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc 12 cm (4.72 in)

Mini disc 8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 110 ms < 130 ms

Full stroke < 210 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate  

24X CD-ROM 3,600 KB/sec

8X DVD 3,600 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec

Transfer mode Multiword DMA mode 2

Startup time < 15 seconds

Stop time < 6 seconds
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DVD-ROM drive
Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital

Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter 1.5 cm (0.59 in)

Disc diameter  

Standard disc

Mini disc

12 cm (4.72 in)

8 cm (3.15 in)

Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random < 100 ms < 125 ms

Full stroke < 175 ms < 225 ms

Audio output level Line-out, 0.7 Vrms

Cache buffer 512 KB

Data transfer rate  

CD-R (24X) 3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2 16.6 MB/s

Startup time < 10 seconds

Stop time < 3 seconds
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System Function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in the
computer. All screws and screw locks listed in this section are available in the Screw Kit, spare part number
443906-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.0mm 5.0 mm

Where used:

(1) Two screws that secure the hard drive cover to the computer (screws are captured on the cover by C-
clips

(2) One screw that secures the Bluetooth module cover to the computer (screw is captured on the cover
by a C-clip)

(3) One screw that secures the memory/WLAN module compartment cover to the computer (screw is
captured on the cover by a C-clip
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Phillips PM2.5×13.0 captive screw

Color Quantity Length Thread Head diameter

Black 1 13.0 mm 2.5 mm 6.0 mm

Where used: One screw that secures the hard drive to the computer
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Phillips PM3.0×3.0 screw

Color Quantity Length Thread Head diameter

Silver 4 3.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5×3.0 screw

Color Quantity Length Thread Head diameter

Black 6 3.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the computer

Where used: 2 screws that secure the WWAN module to the computer
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Where used: 2 screws that secure the modem module to the PC Card/audio board assembly
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Torx T8M2.5×9.0 screw

Color Quantity Length Thread Head diameter

Black 18 9.0 mm 2.5 mm 5.0 mm

Where used:

(1) One screw that secures the optical drive to the computer

(2) Four screws that secure the display assembly to the computer

Where used: 11 screws that secure the top cover to the computer
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Where used: 2 screws that secure the top cover to the computer
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Black 11 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 8 screws that secure the display hinges to the display panel
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Where used: One screw that secures the speaker to the computer
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Black Phillips PM2.5×8.0 captive screw

Color Quantity Length Thread Head diameter

Black 3 8.0 mm 2.5 mm 5.0 mm

Where used: 3 screws that secure the keyboard to the computer
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Torx T8M2.5×17.0 screw

Color Quantity Length Thread Head diameter

Black 1 17.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the display assembly left hinge to the computer
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Torx T8M2.5×7.0 screw

Color Quantity Length Thread Head diameter

Black 3 7.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the display assembly right hinge to the computer

Where used: 2 screws that secure the bottom edge of the display bezel to the display assembly
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Torx T8M2.5×6.0 screw

Color Quantity Length Thread Head diameter

Black 10 6.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the top edge of the display bezel to the display enclosure

Where used: 6 screws that secure the display panel to the display enclosure
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Hex HM5.0×9.0 screw lock

Color Quantity Length Thread Head diameter

Silver 2 9.0 mm 2.5 mm 5.0 mm

Where used: 2 screw locks that secure the top cover to the computer
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Phillips PM2.5×5.0 screw

Color Quantity Length Thread Head diameter

Black 9 5.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the speaker to the base enclosure

(2) Two screws that secure the Media Card Reader/USB connector board to the base enclosure

Where used:

(1) Three screws that secure the system board and the PC Card/audio board assembly to the base
enclosure

(2) One screw that secures the SIM module slot board to the system board

(3) One screw that secures the PC Card/audio board assembly to the system board
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Silver Phillips PM2.5×8.0 captive screw

Color Quantity Length Thread Head diameter

Silver 1 8.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the fan to the computer
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Phillips PM2.5×8.0 screw

Color Quantity Length Thread Head diameter

Silver 1 8.0 mm 2.5 mm 5.0 mm

Where used: One screw that secures the fan to the computer
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Phillips PM2.0×6.0 screw

Color Quantity Length Thread Heat width

Silver 4 6.0 mm 2.0 mm 4.5 mm

Where used: 4 screws that secure the heat sink to the computer
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8 Backup and recovery – Windows
Vista

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● You will need high-quality CD-R, DVD-R, or DVD+R media (purchased separately).

NOTE: Formatted DVD±RW discs and DVD±RW double-layer discs are not compatible with HP
Backup & Recovery Manager.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be
prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.
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Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform Backup & Recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.
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Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally
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NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.
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Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your full
factory image if you experience system failure or instability. HP Backup & Recovery Manager works
from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery
Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition
To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Backup and recovery – Windows XP

Creating recovery discs
After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system and
software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● You will need high-quality CD-R, DVD-R, or DVD+R media (purchased separately).

NOTE: Formatted DVD±RW discs and DVD±RW double-layer discs are not compatible with HP
Backup & Recovery Manager.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create factory software recovery CDs or DVDs to recover the
system (Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.
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Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up
● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions
● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy them
to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform Backup & Recovery procedures, the computer must be connected to
external power.

NOTE: Drivers, utilities, and applications installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.
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Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software applications, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.

Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the first
time you perform a backup. Subsequent recovery points make copies of changes made after that time.
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HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click
Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.
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Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.

Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows
To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition
To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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10 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused

RJ-11 (modem) 137



S-Video-out

Pin Signal

1 S-VHS color (C) signal

2 Composite video signal

3 S-VHS intensity (Y) signal

4 S-VHS color ground

5 TV-CD

6 S-VHS intensity ground

7 Composite video ground

Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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11 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country
or region where the equipment is purchased.

Power cord sets for use in other countries or regions must meet the requirements of the country or region
where the computer is used.

Requirements for all countries or regions
The requirements listed below are applicable to all countries or regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for evaluation
in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating
of 125 or 250 V AC, as required by each country or region's power system.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries or regions
Region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be
used.
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12 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling should be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or see
the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

Symbols/Numerics
1394 port 12

A
AC adapter, spare part

number 26
AC adapter, spare part

numbers 25,  26
accessory battery connector 14
antennae, disconnecting 49,  57
applications key, Windows 8
audio, product description 2
audio-in jack

location 12
pin assignments 135

audio-out jack
location 12
pin assignments 135

B
backing up 124,  130
backup

files and folders 125,  131
hard drive 125,  131
modifications made to the

system 125,  131
scheduling 126,  132

base enclosure, spare part
number 19,  28

battery
location 14
removal 38
spare part numbers 19,  28, 

38
specifications 93

battery bay 14
battery light 9,  11
battery lock latch 14
bezel

removal 67

Bluetooth module
removal 44
spare part numbers 21,  26, 

30,  44
Bluetooth module cable

illustrated 23
removal 72

Bluetooth module compartment 14
Bluetooth module cover

illustrated 22
removal 45

boot options 88
boot order 88
bottom components 14
buttons

info 7
PC Card eject 12
power 6
presentation 7
volume mute 7
wireless 7

C
Cable Kit

contents 23
spare part number 18,  23, 

28
cables, service considerations 31
caps lock light 9
chipset, product description 1
CMOS clearing 36
components

bottom 14
buttons 6
fingerprint reader 6
front 11
keys 8
left-side 12
lights 8
rear 13

right-side 13
switches 6
top 6
TouchPad 10

computer feet
illustrated 22
locations 44

Computer Setup
accessing 84
Diagnostics menu 88
File menu 86
navigating and selecting 85
restoring factory settings 85
Security menu 87
System Configuration menu 88
using 85

computer specifications 90
connectors

accessory battery 14
docking 14
service considerations 31

creating recovery points 125, 
131

D
Diagnostics menu 88
Disk Sanitizer 87
diskette drive

precautions 32
product description 2

display assembly
removal 64
spare part numbers 17,  28, 

64
display bezel

removal 67
spare part number 17,  29

display component recycling 141
display enclosure

spare part number 17,  30
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display hinge
removal 67
spare part number 17,  29, 

68
display inverter

removal 40
spare part number 17,  29, 

40
display panel

removal 68
spare part numbers 17,  29

display release latch 11
Display Rubber Kit, spare part

number 17,  29
Display Screw Kit, spare part

number 17,  29
display specifications 91
display switch 7
docking connector 14
docking support, product

description 4
drive light 9,  11
DriveLock password 87
drives

preventing damage 32
drives, boot order 88
DVD-ROM drive

location 13
precautions 32
removal 51
spare part number 21,  24, 

28,  51
specifications 96

DVD/CD-RW Combo Drive
location 13
precautions 32
removal 51
spare part number 21,  24, 

28,  51
specifications 95

DVD±RW and CD-RW Super Multi
Double-Layer Combo Drive

location 13
precautions 32
removal 51
spare part numbers 21,  24, 

28,  51
specifications 94

E
electrostatic discharge 32
Ethernet, product description 3
Execution Disable 88
external media cards, product

description 3
external monitor port

location 13
pin assignments 136

F
fan

removal 59
spare part number 17,  29, 

59
feet

illustrated 22
locations 44

File menu 86
fingerprint reader 7
front components 11
function keys 8

G
graphics, product description 1
grounding equipment and

methods 35

H
hard drive

location 14
precautions 32
product description 2
removal 42
spare part numbers 19,  24, 

29,  42
specifications 92

hard drive backup 125,  131
hard drive bay 14
hard drive bracket, removal 43
hard drive cover

illustrated 22
removal 42

hard drive recovery 127,  133
hard drive test 88
headphone jack

location 12
pin assignments 135

heat sink
removal 60
spare part number 17,  28, 

60
hinge

removal 67
spare part number 17,  29, 

68

I
I/O address specifications 99
info button 7
interrupt specifications 98
inverter

removal 40
spare part number 17,  29, 

40

J
jacks

audio-in 12
audio-out 12
headphone 12
microphone 12
modem 13
network 13
RJ-11 13
RJ-45 13
S-Video-out 13

K
keyboard

product description 4
removal 53
spare part numbers 17,  29, 

53
keypad keys 8
keys

esc 8
fn 8
function 8
Windows applications 8
Windows logo 8

L
LAN Power Save 88
language, changing in Computer

Setup 88
left-side components 12
legacy support, USB 84,  88
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lights
battery 9,  11
caps lock 9
drive 9,  11
num lock 9
power 9,  11
volume down 9
volume mute 9
volume up 9
wireless 9,  11

M
mass storage devices, spare part

numbers 24
Media Card Reader 13
Media Card Reader/USB connector

board
removal 74
spare part number 74
spare part numbers 19,  28, 

29
memory check 88
memory map specifications 101
memory module

product description 2
removal 46,  55
spare part numbers 18,  26, 

46,  55
memory/WLAN module

compartment 14
memory/WLAN module

compartment cover
illustrated 22
removal 46

microphone
illustrated 23
removal 71

microphone jack
location 12
pin assignments 135

modem jack
location 13
pin assignments 137

modem module
product description 3
removal 80
spare part number 28
spare part numbers 19,  80

modem module cable
illustrated 23
removal 72

monitor port
location 13
pin assignments 136

N
navigating in Computer Setup 85
network jack

location 13
pin assignments 137

num lock light 9

O
operating system, product

description 4
optical drive

location 13
precautions 32
product description 2
removal 51
spare part numbers 21,  24, 

28,  51
specifications 94,  95,  96

optical drive bracket, removal 52

P
packing guidelines 34
panels, product description 1
parallel port mode 88
password clearing 36
passwords 87
PC Card eject button 12
PC Card slot 12
PC Card slot bezel, illustrated 22
PC Card/audio board assembly

removal 79
spare part number 18,  28, 

79
pin assignments

audio-in jack 135
audio-out jack 135
external monitor port 136
headphone jack 135
microphone jack 135
modem jack 137
monitor port 136
network jack 137
RJ-11 137
RJ-45 jack 137

S-Video-out jack 138
Universal Serial Bus (USB)

port 138
plastic parts 31
Plastics Kit

contents 22
spare part number 18,  22, 

28
pointing devices, product

description 4
ports

1394 12
external monitor 13
monitor 13
product description 3
Universal Serial Bus (USB) 12, 

13
power button 6
power connector 12
power cord

set requirements 139
spare part numbers 25,  26

power light 9,  11
power requirements, product

description 4
power-on password 87
presentation button 7
processor

product description 1
removal 62
spare part numbers 18,  26, 

28,  29,  30,  62
product description

audio 2
chipset 1
diskette drive 2
docking support 4
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 2
modem module 3
operating system 4
optical drives 2
panels 1
pointing devices 4
ports 3
power requirements 4
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processors 1
security 4
serviceability 4
wireless 3

R
rear components 13
recovery discs

creating 123,  129
using 127,  133

recovery partition 128,  134
recovery points 125,  131
removal/replacement

preliminaries 31
procedures 37

restoring Computer Setup factory
settings 85

right-side components 13
RJ-11 jack

location 13
pin assignments 137

RJ-45 jack
location 13
pin assignments 137

RTC battery
removal 56
spare part number 19,  29, 

56

S
S-Video-out jack

location 13
pin assignments 138

scheduling backups 126,  132
Screw Kit

contents 102
spare part number 25,  28

screw listing 102
security cable slot 13
Security menu 87
security, product description 4
selecting in the Computer

Setup 85
serial number 15,  37
service considerations 31
serviceability, product

description 4

SIM module slot board
removal 82
spare part number 19,  28, 

82
SIM module, removal 39
Smart card reader module, spare

part number 25,  28
smart card security 87
speaker

removal 73
spare part number 19,  28, 

73
speakers 11
specifications

battery 93
computer 90
display 91
DVD-ROM drive 96
DVD/CD-RW Combo Drive 95
DVD±RW and CD-RW Super

Multi Double-Layer Combo
Drive 94

hard drive 92
I/O addresses 99
interrupts 98
memory map 101
optical drive 94,  95,  96
system DMA 97

startup check 88
static-shielding materials 35
stringent security 87
switch cover

removal 58
spare part number 17,  29, 

58
system backup 125,  131
system board

removal 76
spare part numbers 19,  28, 

76
System Configuration menu 88
system DMA 97
system fan 88
system information 86
system memory map 101
system recovery points 125,  131

T
Thermal Material Kit, spare part

number 17,  26

Thermal Material Kit, spare part
numbers 29

thermal material, replacement 61
tools required 31
top components 6
top cover

removal 69
spare part number 18,  29, 

69
TouchPad 10
TouchPad button 10
TouchPad components 10
TouchPad scroll zone 10
transporting guidelines 34

U
Universal Serial Bus (USB) port

location 12,  13
pin assignments 138

unknown password 36
USB legacy support 84,  88

V
vents 12,  14
volume down light 9
volume mute button 7
volume mute light 9
volume scroll zone 7
volume up light 9

W
Windows applications key 8
Windows logo key 8
wireless antennae,

disconnecting 49,  57
wireless button 7
wireless light 9,  11
wireless, product description 3
WLAN module

removal 48
spare part numbers 19,  26, 

27,  48
workstation guidelines 34
WWAN module

removal 57
spare part numbers 17,  26, 

28,  57
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